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Warranty 
Sensimetrics Corporation warrants for a period of 90 days that this product will be free 
from defects in materials, workmanship, or recording.  If HeLPS does not work as 
described in the accompanying documentation, and your problem cannot be resolved, 
Sensimetrics will either provide upgraded software or authorize you to return the product 
for a refund. 
 
 
Technical Support 
One year of free technical support for HeLPS is provided from the date of purchase.  
If you need technical support, please visit the HeLPS website www.sens.com/HeLPS and 
click on the Support link for help with known problems and for answers to Frequently 
Asked Questions (FAQs). If your problem is not addressed there, send a description of it 
by email to tech-support@sens.com, or by mail to: 
  
    HeLPS Technical Support 
    Sensimetrics Corporation 
    48 Grove St. 
    Somerville, MA 02144   U.S.A. 
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INTRODUCTION 
 
HeLPS – the Hearing Loss and Prosthesis Simulator – simulates the auditory 
communication difficulties associated with hearing loss along with the benefits provided 
by hearing aids and cochlear implants. HeLPS allows flexible demonstrations during 
hearing aid fitting; when counseling families of hearing-impaired and deaf persons; in 
hearing-conservation and public education programs; and in training audiologists and 
educators of the deaf. 
 
HeLPS provides a graphic interface on your computer for controlling the simulation and 
a set of Sennheiser HD 201 circumaural headphones for listening to the simulator’s 
output. To allow the listener to use speechreading, HeLPS provides audio/visual stimuli 
with the audio component processed by the simulator. Hearing and prosthesis 
characteristics are specified separately for the left and right sides, with convenient 
controls for selecting loss and prosthesis settings, talkers, background noises, and 
reverberation. 
 
After Installation and Setup, described in the next section, you can proceed to the Quick 
Start section to become familiar with the operation of HeLPS. Subsequent sections of this 
User Guide explain in detail the simulation algorithms and advanced use of the control 
interface.  
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 SOFTWARE INSTALLATION AND AUDIO SETUP 
 
Software Installation 
Insert the HeLPS CD-ROM into your computer’s CD-ROM drive and the HeLPS Install 
Menu should automatically appear. If it does not appear, navigate to the top-level folder 
of the CD-ROM and double-click the file ‘Setup.exe’ to launch it. Then follow the on-
screen installation instructions.  
 
After installation is complete, you can run HeLPS by going to the Windows Start Menu, 
then to All Programs, and selecting HeLPS. 
 
Sound Level Calibration 
Before using HeLPS for the first time, a calibration step must be performed. The stimuli 
and the simulation system have already been calibrated for use with the Sennheiser HD 
201 headphones provided with HeLPS. This calibration corrects for the shape of the 
frequency response of the headphones. The calibration also assumes that the audio 
playback system in your computer and any additional amplifiers that you are using have a 
reasonably flat frequency response. However, that calibration is not sufficient because the 
output sound levels from individual PCs and amplifiers are unknown, even when driven 
by the same stored digital signal. It is therefore necessary for you to perform a calibration 
of the output level stage, as described in the following steps. 
 
1) Connect the headphones to your computer’s headphone output jack.   
 
2) Start HeLPS and go to the SIM SETTINGS window. The Normal Hearing and No Aid 
entries in the table will be in boldface, indicating that they are the active hearing and 
prosthesis simulations. If you have gotten to the SIM SETTINGS window some other 
way and these two entries are not bold-face, single-click them to make them active. 
 
3) This third step can be done in either of two ways, depending on whether you have 
acoustic measurement equipment. 
 
3-a) If you have measurement equipment, such as a probe microphone for making sound 
level measurements under the headphone, or a sound level meter with a flat-plate coupler, 
then you can do the calibration acoustically using a steady noise stimulus. To deliver this 
stimulus, select HeLPS A/V Clips with No Talker as the Selection. Then choose Speech-
Shaped Noise, Front, 65 dB SPL, Continuous, and set Reverberation to Anechoic. Then 
click Play and a steady noise stimulus (with brief occasional pauses) will be presented 
whose overall level should be easy to measure with your equipment. Go to Step 4. 
 
3-b) If you do not have measurement equipment you must use your own ears to perform a 
‘biological’ calibration that relies on your familiarity with conversational speech levels. 
To deliver the speech stimulus, select HeLPS A/V Clips with All Talkers. Set the Target 
Level to 65 dB SPL, set Noise to None, and Reverberation to Anechoic. This will result 
in a sequence of sentences spoken by ten randomly-selected talkers. The loudness of this 
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speech heard over the headphones should be equivalent to that of a face-to-face 
conversation at a distance of 1 meter.  
4) Go to the Advanced menu and select Output Calibration. Use the slider in that window 
to adjust the stimulus to achieve the criterion of 65 dB SPL if you are measuring noise, or 
normal conversational loudness if you are listening to speech.  
 
5) The value of Maximum Output Level shown to the right of the slider tells you the 
maximum level of speech that the system will be capable of producing.  The Minimum 
Output Level is the lowest signal level that can be represented in 16 bits given the need to 
represent speech at the Maximum RMS level (plus a 15 dB peak factor). The Minimum 
Output Level is simply 75 dB lower than the Maximum Output Level. For most 
applications, the most important consideration will be to have sufficient Maximum 
Output Level range (“headroom”) available for delivering hearing-aid amplified stimuli. 
If the Maximum Output Level is less than 85 dB, the combination of input level and 
hearing aid gain that you can use will be insufficient. Limited headroom results when 
there is too little gain following the computer’s audio output. The first place to look to 
adjust output gain is Windows’ internal volume control. This control is accessed by right-
clicking the small loudspeaker icon located in the taskbar at the bottom-right of the 
screen, and then selecting Open Volume Control. An array of sliders will appear for 
controlling the several audio sources on your computer. The Volume Control and Wave 
sliders both control audio output level. Adjust these two sliders to increase volume and 
then go back to Step 3 and repeat the calibration. 
 
In most typical PC-audio configurations, with the Sennheiser HD 201 headphones 
plugged into the PC’s headphone jack and the Windows Volume Control and Wave 
sliders at their highest settings, HeLPS with proper output calibration will be capable of 
delivering speech at a maximum output level of at least 90 dB SPL. 
 
If you cannot achieve the output levels you need by maximizing the Windows volume 
controls, then the only other solution is to amplify the PC audio output. Consumer-grade 
amplifiers will suffice. Remember that if you insert an amplifier between the PC audio 
output and the headphones, you must repeat the calibration after the amplifier gain has 
been fixed. 
 

                        WARNING! 
 
HeLPS is capable of delivering very high sound levels.  Be careful when 
conducting demonstrations, especially with simulated hearing aids, that 
the sounds are not uncomfortably loud for the listener.  

 
It is critical that, once the sound level calibration is done, the volume controls (both 
within Windows and any subsequent amplifier) be adjusted to the same settings when 
using HeLPS subsequently. It is smart to note what these settings are so that they can be 
replicated. If the controls change and you don’t know how to reproduce them, then the 
calibration should be repeated. 
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Fortunately, the accuracy of the HeLPS simulation is not sensitive to the precision of this 
output level calibration, making the biological calibration adequate. The more important 
calibration is at the input to the simulation because it is the level of the input signals 
relative to the elevated detection thresholds that primarily determines the audibility of 
signals and the intelligibility of speech. Small errors in output level may affect loudness, 
which is important when estimating the annoyance of amplified sounds, but less 
important when estimating intelligibility.  
 
If you are delivering the audio via loudspeakers (which is appropriate for some types of 
demonstrations), the same type of calibration must be performed and maintained. For 
more information on using loudspeakers with HeLPS, see “Presenting Simulations to 
Multiple Listeners” in the section titled “Controlling the Simulation” in this User Guide. 
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QUICK START 
 
Use of HeLPS can be learned easily by hearing professionals. This Quick Start tutorial 
will make the program’s basic features clear in about fifteen minutes.  
 
The block diagram in Figure 1 shows the signal flow of the complete simulation along 
with annotations identifying the available controls. The basic function of HeLPS is to 
deliver a continual sequence of target stimuli, possibly with added noise, with the audio 
processed by a specific prosthesis simulation and a specific hearing loss simulation. The 
target stimuli are specified by playlists. One playlist available with HeLPS is a large 
collection of audio/video recordings of people speaking sentences. You can also supply 
your own playlist of signals (containing audio only) for use as targets.  
 
Target signals can be combined with either of two types of noise – speech-spectrum 
(random) noise and party noise. Target and noise signals are processed to simulate sound 
propagation and head-diffraction in either an anechoic or a reverberant environment. The 
combined target-plus-noise signal reaching the microphone of each simulated prosthesis 
(hearing aid or cochlear implant) is subjected to the specified prosthesis simulation, or is 
simply passed through the system if there is no prosthesis. The left and right ear signals 
are then processed through simulations of the left and right hearing losses, respectively, 
and then finally played from the computer for listening through Sennheiser HD 201 
headphones.  
 

 

Figure 1. Block diagram showing the main signal and signal-processing components  
of the HeLPS simulation. 
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All HeLPS simulation controls are accessed via three main interface windows: 1) Hearing 
for specifying the characteristics of hearing losses to be simulated; 2) Prosthesis for 
specifying the characteristics of simulated hearing aids or cochlear implants; and 3) SIM 
SETTINGS, for selecting targets, noises, and acoustic environments, and for convenient 
switching among hearing and prosthesis specifications. 
 
If you have not already done so, start HeLPS now. Then let’s look at the SIM SETTINGS 
window, which automatically appears when the program is started.  
 
The SIM SETTINGS Window 
When you are in the SIM SETTINGS window, go to the Help menu and select Display 
Annotation. This will bring up an example SIM SETTINGS window with key parts 
annotated. This annotated Help window will change along with the main window as we 
work through this tutorial (or whenever you bring it up). The Help window can be closed 
by clicking ‘X’ in the upper right corner.  
 
Most of the controls for stimulus selection and playback are self-explanatory. You can 
begin to manipulate any of these controls, but first click Play to start the presentation of 
target stimuli. 
 
The use of the table in this window, called the Program Table, requires some explanation. 
The Program Table is the place where different hearing and prosthesis specifications can 
be loaded. The first entries are exceptions, reserved for the commonly used Normal 
Hearing and No Aid, and cannot be changed. This table allows you to switch quickly 
among a small set of hearing and prosthesis specifications.  
 
At any time, one hearing specification and one prosthesis specification in this table are 
the active ones being used in the running simulation. The active specifications are 
indicated by boldface labels. You can activate any hearing and any prosthesis entry in the 
table by single-clicking it.  
 
When the program is first started, all of the specifications in the Program Table are 
Normal Hearing and No Aid. To aid in learning to use HeLPS, the Program Table 
illustrated in the annotated Help window is provided. To load it from the SIM 
SETTINGS window, go to the File Menu and select Open. Then navigate to the folder 
C:\...\HeLPS\work\examples and Open the file Assorted.prog. This will load an 
assortment of hearing and prosthesis specifications. You can then select any combination 
of hearing and prosthesis specifications by single-clicking on them. Make sure that 
stimuli are playing; press the Play button if they are not.  
 
Hearing and prosthesis specifications in the Program Table are identified with short 
labels. To get a detailed description of a specification, double-click its label. This will 1) 
make the selected specification the active one; 2) bring up either the HEARING window 
or the PROSTHESIS window, depending on which type of specification was selected; 
and 3) “link” the Hearing or Prosthesis specification window to the simulation. In this 
linked state, any changes you make in the specification window will be made 
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immediately in the ongoing simulation, giving you direct active control. This linked state 
is indicated in the HEARING or PROSTHESIS window by an asterisk to the left of the 
label box; in the SIM SETTINGS window it is indicated by an asterisk next to the 
specification that was double-clicked.  
 
The Hearing Window 
Continuing with the same example, if you go to SIM SETTINGS and double-click the 
hearing specification labeled Sloping 55 at 1k in the Program Table, a HEARING 
window will appear showing that hearing specification. This particular hearing 
specification describes a moderate bilaterally-symmetric hearing loss that slopes 
downward at 10 dB/oct, with HL = 55 dB at 1 kHz, with equal Bone-Conduction (BC) 
and Air-Conduction (AC) thresholds. There is no tinnitus accompanying this loss. 
(Tinnitus controls can be viewed or hidden via the View menu). Note that losses that are 
not bilaterally-symmetric are specified separately for each ear, selected with the buttons 
above the audiogram. 
 
Now adjust the thresholds by clicking in the audiogram at the desired frequency. By 
clicking (depressing) either or both of the two buttons to the right of the audiogram you 
can adjust either the BC threshold alone, the AC threshold alone, or both AC and BC 
thresholds together (making them equal). Note that the interface automatically enforces 
the constraint that BC thresholds cannot be larger than AC thresholds.  
 
When stimuli are playing, you can hear the effects of changes you make in the hearing 
specification. This linkage is in effect because you double-clicked the hearing 
specification in the Program Table. Linkage is indicated by the asterisk to the left of the 
specification label. If you came to the HEARING window without having first linked by 
double-clicking a hearing entry in the Program Table, the specification would not be 
linked and changes would not be directly implemented in the active simulation. The 
changes would, however, be made to the specification and would be saved if you choose 
to save them.  
 
The Prosthesis Window 
Return to the SIM SETTINGS window (by clicking its tab), and double-click on the 
prosthesis specification labeled NAL_RP for Sloping 55. The PROSTHESIS window 
will appear showing that specification. The PROSTHESIS window for hearing aids 
presents parameters and controls that are familiar to those who work with hearing aids. 
The main controls are the channel gains for 1, 2, or 3 channels, which are adjusted by 
clicking and dragging the graphic handles in the spectral plots. These plots show the 
third-octave spectra in a listener’s ear canals when presented with speech-spectrum noise 
at input levels of 55, 70, and 85 dB SPL. If you now go to the Import Loss menu and 
select From Hearing Window, the hearing loss currently in the HEARING window, 
which should now be “Sloping 55 at 1k,” will be plotted in terms of dB SPL on the 
spectral plot. With a hearing loss imported, you can now select a prescription method by 
going to the Prescribe menu. The target output levels prescribed by the selected fitting 
prescription will be plotted. You could then adjust channel gains to match the targets if 
you wished. 
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If you have followed along with this tutorial and double-clicked in the Program Table, 
then the prosthesis specification you are controlling in the PROSTHESIS window is 
linked to the active simulation (indicated by the asterisk to the left of the specification 
label). Feel free to adjust the hearing aid’s parameters and listen to the resulting effect on 
the output audio.  
 
Clicking on the other two prosthesis options shows that: with None there are no controls 
or parameters to adjust, and with Cochlear Implant the only available controls are the 
Number of Channels (1-20) and the Carrier (noise or tone). If the prosthesis specification 
is still linked to the active simulation, you should hear the appropriate differences when 
you select these prosthesis options.  
 
This Quick Start tutorial has illustrated the most important and frequently-used features 
of HeLPS. The next two sections of this User Guide describe the algorithms used to 
simulate hearing losses and prostheses.  Later sections describe in detail how to use the 
interface to achieve desired simulations.  
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HEARING LOSS SIMULATION 
 
The HeLPS algorithm for simulating hearing loss is designed to produce for the listener 
the absolute detection thresholds (i.e., hearing levels) and the sensation of loudness 
recruitment that are associated with a specified hearing loss. The source signals that are 
processed by the simulation are recorded audio signals stored on your computer. These 
source signals have been calibrated so that they can be presented at known equivalent 
sound pressure levels and processed accurately for the specified degree of hearing loss. 
With a given simulated hearing loss, a listener will hear these processed sounds and will 
experience loudness recruitment in approximately the same way as a person with the 
specified actual hearing loss.  
 
This section of the User Guide describes the HeLPS hearing loss simulation algorithm.  
A later section, entitled “Specifying Simulated Hearing Losses,” will explain how to use 
the HeLPS interface to specify the characteristics of simulated hearing losses. 
 
The HeLPS Algorithm 
The HeLPS simulation algorithm uses a model of hearing loss that allows simulation of 
two types of loss – conductive and recruiting. Consider conductive hearing loss, which is 
modeled as a fixed frequency-dependent attenuation of the input signal. The degree of 
conductive threshold shift in a given frequency band is denoted in the model as HC.  

Figure 2 shows the simulation of an example conductive loss in the form of an 
input/output (I/O) plot. In this plot the input quantity, plotted on the abscissa, is the sound 
level in a given frequency band at the listener’s eardrum with no simulation or device in 
place (i.e., open ear). The output, plotted on the ordinate, is the level of the sound at the 
listener’s eardrum contributed by the hearing loss simulation. The dotted line for out=in 
simulates normal hearing. Note that these I/O plots give sound levels relative to the 
normal absolute threshold for the band. On average, therefore, sounds that exceed an 
output level of 0 dB will be heard by a normal-hearing listener and those below 0 dB will 
not be heard.  

 
 
 
 
Figure 2. An example I/O plot for one 
simulator band showing a conductive 
hearing loss of HC  = 40 dB.  
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The simulator I/O plot in Figure 2 shows a purely conductive loss of 40 dB. Because a 
conductive loss is modeled as a fixed attenuation, the simulator output level is simply 40 
dB lower than the input level at all input levels. Simulator output sounds begin to be 
audible (i.e., exceed 0 dB output level) when the input reaches 40 dB, with the output 
level continuing to increase 1 dB per 1 dB increase in input level above threshold.  

Now, consider recruiting hearing loss, which is the second type of hearing loss allowed in 
the simulation algorithm and which is denoted HR. A recruiting loss is modeled as a 
threshold shift with a rapid rise in output level as signal level increases over some 
recruitment range r above threshold, until full recruitment is reached. At that point, 
output level increases 1 dB per 1 dB increase in input level.   

Figure 3 shows the I/O plot for a recruiting loss of 70 dB (HC = 0, HR = 70). For this type 
of loss the simulator output level is less than 0 dB for input signal levels below the 
specified threshold-relative input level of 70 dB. As the input level increases above 70 dB, 
the simulator output level rises rapidly over the recruitment range of r =20 dB in this 
example. Because there is no conductive loss, the output level at and above the point of 
full recruitment is equal to the input level (out=in). 

 

What happens with a mixed loss? Figure 4 shows the simulator I/O plot for a hearing loss 
with a conductive component of 20 dB and a recruiting loss of 50 dB (HC = 20, HR = 50). 
In this case the simulator output still begins to exceed 0 dB when the input level reaches 
the total hearing loss (HL= HC +HR) of 70 dB. The output still has a recruitment range of 
20 dB, but now, because of the conductive component, the simulator output in the full-
recruitment region remains 20 dB below the input level.  

 

 
 
 
 
 
 
Figure 3. An example I/O plot for one  
simulator band showing a recruiting  
hearing loss HR = 70 dB with a  
recruitment range r = 20 dB.  
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The signal processing required to achieve the simulator I/O characteristics just described 
is shown in Figure 5 and is relatively straightforward. The input signal is first filtered into 
bands. The sound level of each bandpass signal is then estimated over a short time 
interval, and this estimate is used to control the gain, g, of an attenuator through which 
the filtered signal passes. This automatic gain control (AGC) is varied to achieve the 
desired I/O characteristic. In terms of the I/O plot, the amount of attenuation needed as a 
function of input level is given by the vertical distance between the simulator output 
characteristic and the out=in line. For recruiting hearing losses, this distance is a function 
of the running estimate of input level; more attenuation is applied to lower sound levels 
than to higher sound levels. Processing in different frequency bands has the same form, 
but uses different parameters, in general, for the AGC.  
 

 
 
 
 
Figure 4. An example I/O plot for 
one simulator band showing a mixed 
hearing loss with HC  = 20 dB and  
HR  = 50 dB,  with a recruitment 
range r = 20 dB.  
 

Figure 5. Block diagram showing the signal processing in one band of the  
hearing loss simulation. 



HeLPS User Guide                                                                                                                                   12   

 SENSIMETRICS CORPORATION 

The use of AGC to simulate recruiting hearing loss was first described by Villchur (1977) 
and later studied by Duchnowski and Zurek (1995) and Lum and Braida (2000). Those 
studies have shown reasonably good agreement of scores on psychophysical and speech-
reception tests between listeners with actual hearing losses and listeners with simulated 
losses matched to the actual losses. The validity of a hearing loss simulation that 
incorporates only threshold shift and recruitment is supported by numerous other studies 
that have used noise-masking simulations of hearing loss (Zurek and Delhorne, 1987; 
Humes et al., 1987; Dubno and Dirks, 1993).  
 
I/O plots characterize the steady-state response of the simulator. However, because the 
input level must be estimated over some short time interval, there will be system transient 
responses to changes in level. In HeLPS, the input level estimate is obtained by forming a 
running average of the square of the bandpass-filtered input signal, with a time constant 
of 14 msec.  This degree of temporal resolution was chosen as a trade-off that minimizes 
the effects of audible distortion (with a shorter time constant) and sluggish response (with 
a longer time constant).  
 
Tinnitus can also be simulated as part of the HeLPS hearing loss simulation. Tinnitus is 
simulated by the addition of tones or bandpass noise at the desired sound level to the 
output, as specified by the user.   
 
Although only one side (ear) of the HeLPS hearing loss simulator has been discussed 
here, the simulation is binaural, with independent operation on the left and right sides.  
 
Simulation Limitations 
There are several limitations to the HeLPS simulations that should be understood in order 
to make valid and effective use of the system. 
 
Ambient Sounds 
Because HeLPS uses headphones with little sound attenuation, the listener will be able to 
hear ambient sounds easily. The audibility of ambient sounds is inconsistent with the 
demonstration of hearing loss that is the goal of the simulation. To achieve maximal 
impact, demonstrations should be given in quiet places. 
 
Suprathreshold and/or Central Deficits 
The hearing loss simulation implemented by HeLPS is designed to duplicate the 
threshold shift and loudness recruitment of a specified hearing loss. This type of 
simulation has been shown to give a good match to the performance of listeners with 
actual hearing impairments on a variety of psychoacoustic and speech-reception tasks. 
Some hearing-impaired listeners, however, exhibit performance that is clearly worse than 
simulated-loss listeners on such tasks. Listeners with auditory neuropathy (Sininger and 
Starr, 2001), for example, form one group to whom the HeLPS simulation does not apply. 
Currently, the suprathreshold deficits that underlie such poorer performance are not 
sufficiently understood to enable them to be simulated.  
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The HeLPS hearing loss simulation also does not account for cognitive or central deficits 
that might lead to poorer performance on psychoacoustic or speech-reception tasks. Such 
deficits, which are most commonly seen in some elderly patients, are not simulated by 
HeLPS. 
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PROSTHESIS SIMULATION 
 
HeLPS provides simulations of the two most common types of auditory prostheses – 
hearing aids and cochlear implants. This section of the User Guide describes the main 
components of these simulations. A later section (“Specifying Simulated Prostheses”) 
will describe how to use the HeLPS interface to control their characteristics.  
 
Hearing Aids 
The hearing aids that can be implemented by HeLPS are constructed according to the 
prototype block diagram in Figure 6. This diagram shows the prototype for one side only; 
the prototype for the other side is identical. If bilateral aids are used in HeLPS, they 
operate independently. In addition, fixed correction filters on the input and output are not 
shown.  
 

 
Microphone Directionality 
The microphones on a HeLPS hearing aid can be either omnidirectional or directional. 
Either type of microphone is simulated as sensing points on a rigid-sphere model of the 
head. The directional microphone response in free space has the cardioid polar response 
pattern shown in the inset in Figure 6. Directional microphone processing includes 
compensation to make the on-axis (0o) frequency response the same for omnidirectional 
and directional microphones. Other compensations can be implemented with the pre-
emphasis filter described below. 
 

Figure 6. Block diagram of the prototype hearing aid implemented by HeLPS.  
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Pre-Emphasis Filter 
An adjustable linear filter is provided to allow for spectral shaping prior to compression. 
The magnitude response of this filter can be controlled via adjustment of a center 
frequency and variable-slope skirts above and below that center frequency.  
 
Compressor 
The compressor provides independent automatic gain control in up to three frequency 
channels. The crossover frequencies between channels are adjustable, as are the 
input/output characteristics and time constants within each channel. Note that all HeLPS 
hearing aids are, strictly speaking, compression hearing aids, because the compressor is 
always active. Linear hearing aids are achieved by specifying gain that is fixed, 
independent of input level. 
 
Volume Range and Control 
The range of gain on the hearing aid’s volume control can be specified.  Note that the 
placement of the volume control following the compressor results in the type of 
compression known as “input compression” (Dillon, 2001). 
 
Simulation Limitations 
An important difference between real hearing aids and HeLPS hearing aids is that there is 
no feedback in HeLPS aids. Consequently, there is no limit to the maximum gain that can 
be provided by a simulated aid. With actual hearing aids a point of instability will be 
reached when excessive gain is used.  
 
Cochlear Implants 
The HeLPS cochlear implant simulation is shown in Figure 7.  The pre-processing is the 
same as for hearing aids: selection of an omnidirectional or a directional microphone and 
pre-emphasis filtering. The number of channels, N, in the simulation is an important 
parameter. Specifying N results in the audio band from 0.1 – 9 kHz being separated into 
N channels of equal width in octaves. Varying the number of channels can be used to 
adjust the quality of the signal representation and the resulting psychoacoustic 
performance, with a larger number of channels leading to better performance.  
 
It is important to note that the number of channels in the CI simulation is not simply 
related to the number of channels or electrodes in an actual implant.  The number of 
simulation channels only provides a means of controlling spectral resolution and, thereby, 
psychoacoustic performance, and should not be taken as a literal equivalent to the number 
of channels in an actual implant.  
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The processing performed within any channel of the cochlear implant simulation is 
shown in the inset of Figure 7. This simulation processing is similar to that described in 
the literature (e.g., Friesen et al., 2001; Qin and Oxenham, 2003) in which the envelopes 
of bandpass filtered signals modulate either noise band or tone carriers. Some researchers 
have found no difference in speech reception between these two carrier types (Dorman, 
Loizou, and Rainey, 1997) while others have observed slightly better speech performance   
with tone carriers (Whitmal, et al., 2004). But even if one carrier does give better scores 
than the other, that alone is not a reason for supposing that it provides a better CI 
simulation. At this point it is not clear which carrier type should be used. The main point 
to be made with demonstrations to family members is that a range of performance with 
CIs can be expected, and this range can be demonstrated by varying channel number 
using either carrier.   
 
Simulation Limitations 
Simulating cochlear implant stimulation for a normal-hearing person is more complicated 
than simulating acoustic stimulation with hearing aids. A person who uses a cochlear 
implant typically has a hearing loss that is severe-to-profound or profound. Yet this very 
large hearing loss, which is most often due to hair cell damage or loss, is circumvented 
with direct electrical stimulation of the auditory nerve. The loss of information along the 
pathway from acoustic signal, through the implant, to representation in the central 
auditory system is still poorly understood. The unexplained variability in performance of 

Figure 7. Block diagram of the prototype cochlear implant simulation. The processing 
performed within any one channel of the implant simulation is shown in the inset. 
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implantees on psychoacoustic and speech-recognition tasks (e.g., Munson, et al., 2003), 
and the difficulty in predicting implanted performance from pre-implantation measures, 
reflect this basic ignorance.  
 
The accuracy of current state-of-the-art cochlear implant simulations is correspondingly 
limited. Performance of listeners using the simulation is controlled only by varying the 
number of channels. Unlike the case of acoustic hearing, where threshold shifts provide a 
fairly accurate basis for simulating performance on speech-recognition and 
psychoacoustic tasks, there are no such clinical measurements that can be used to 
customize the simulation to a specific cochlear implant user.  
 
The complexity of cochlear implants also requires an accommodation to the HeLPS 
simulation. Because cochlear implant users receive electrical stimulation that by-passes 
the acoustic path, it is impossible to simulate simultaneously their threshold shifts and the 
loudness of the stimulation they receive. If implantees’ very large losses were simulated 
accurately, the audible stimulation that could be delivered acoustically would be very 
loud. Actual implantees, however, receive their electrical stimulation at levels that go 
down to their absolute detection thresholds, and so can be very soft.  
 
The accommodation that has to be made for HeLPS simulation of cochlear implants is to 
simulate normal hearing in the ear with the implant. Even though it seems wrong to 
simulate normal hearing for a person with a profound hearing loss, it is necessary to 
achieve the simulation. The simulator’s CI output levels have been chosen so that they 
are clearly audible and comfortable to the listener when no hearing loss is simulated.  
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SPECIFYING SIMULATED HEARING LOSSES 
 

When the HEARING tab of the HeLPS interface is clicked, a window will appear in 
which you can specify simulated hearing loss and tinnitus for the two ears. Symmetrical 
and asymmetrical losses can be generated by using the buttons located at the top of the 
audiogram to specify the losses for the right ear, the left ear, or both ears simultaneously.  
 
Hearing Loss 
Hearing loss for a particular ear (or for both ears simultaneously) is specified by entering 
air-conduction (AC) and bone-conduction (BC) thresholds into the audiogram. The 
buttons to the right of the audiogram labeled AC and BC determine which type of 
threshold will be entered. Equal AC and BC thresholds may be specified by depressing 
both the AC and BC buttons at the same time. If AC and BC thresholds are entered 
separately, HeLPS will automatically enforce the restriction that the BC threshold must 
not exceed the AC threshold.  
 
AC and BC thresholds are accepted at ten frequencies: the six octave frequencies from 
0.25 to 8 kHz plus the four inter-octave frequencies of 0.75, 1.5, 3 and 6 kHz. Entries at 
0.25, 1, and 4 kHz are required and cannot be deleted. Threshold entries at the other 
seven frequencies can be added or deleted as desired.  Threshold entries (AC or BC or 
both, depending upon the setting of the AC and BC buttons) may be added or adjusted by 
clicking on the audiogram at the desired frequency and the desired HL, which is indicated 
in the telltale (the small yellow box that pops up to display numerical values), and then 
clicking. Thresholds at any of the seven non-required frequencies can be deleted by right-
clicking on one of the thresholds at that frequency and selecting Delete Frequency. 
 
The gray swath in the audiogram gives the average speech spectrum range. At each 
frequency it extends vertically between X+12  to X-18 dB where X is the average third-
octave band level of normal conversational speech measured in a free field, 1 m in front 
of a talker (ANSI S3.5, 1997), expressed in terms of hearing level (ANSI S3.6, 1996). 
 
The AC and BC thresholds that are entered in a hearing specification determine the 
conductive and recruiting components, HC and HR, respectively, of the total hearing loss, 
HL, as described above (in “Hearing Loss Simulation”). In the HeLPS simulation, these 
hearing loss components are related to the audiometric measurements by  
 
    HR = BC, 
    HC = AC – BC (aka ‘air-bone gap’), 
and  
    HL = HC + HR = AC. 
 
Simulation Limits 
As mentioned above, during threshold entry, the graphical interface imposes the 
constraint that the BC threshold cannot be larger than the AC threshold. If you enter a BC 
threshold that is larger than the current AC threshold at that frequency, the interface will 
automatically change the AC threshold to be equal to the new BC threshold. 
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Tinnitus 
You can specify the characteristics of either tonal or noisy tinnitus. To display the 
Tinnitus Controls, enable them from the View menu. For tonal tinnitus, the frequency and 
level of up to three continuous sine wave signals can be specified (with level specified in 
dB SPL). Noisy tinnitus is simulated by a continuous band of noise, and is specified by 
its lower and upper band limits and its overall level. 
 
Simulation Limits 
The following limits apply to the tinnitus simulation: 

1) Tonal tinnitus frequencies must be below 11025 Hz. The highest cutoff for noise 
tinnitus must be less than 11003.  

2) Both tone and noise tinnitus levels are limited to be less than 85 dB SPL. 
3) If tonal tinnitus is specified for both ears at the same frequency, those tones will be 

presented in-phase. Noise tinnitus is uncorrelated between sides, even if their 
spectra overlap.  

 
Copying, Saving, Importing, Linking and Printing 
The entire collection of data that describes a given simulated hearing impairment (AC 
and BC thresholds and tinnitus characteristics for the two ears) is called a hearing 
specification. A hearing specification must have an identifying label in the box at the top 
of the window. The interface will not allow the label box to be empty and will insert a 
label such as “Untitled Hearing 1” if necessary. 
 
Two forms of copying are available while in the HEARING window. First, you may copy 
the specification for one ear to the other ear through the use of the COPY button, which is 
located to the right of the audiogram when either the Right ear or Left ear audiogram 
display option is active. This is useful when designing similar right and left specifications.  
 
Second, you may copy a hearing specification to a “clipboard” for use in other windows 
of the HeLPS interface. For example, if you want to use the current hearing specification 
for a demonstration, you can copy it to the clipboard (by going to the Edit menu and 
selecting Copy or by typing Ctrl-c) and then insert it into the Program Table by switching 
to the SIM SETTINGS window, single-clicking on a hearing entry in the Program Table, 
and pasting it (by going to the Edit menu and selecting Paste or by typing Ctrl-v). [Use of 
the Program Table is described in more detail later in “Controlling the Simulation”]. 
 
A hearing specification can be saved to a hearing file, which will be given the extension 
“.hrg”. To save a specification to a file, go to the File menu, select Save As, and then 
specify a folder and file name in the usual way. The file name will then be displayed in 
the title bar at the top edge of the window. Before a specification is saved to a file a 
temporary name such as Untitled_Hearing_3 is displayed there. Changes made in a 
specification window are not made to the associated file (if there is one) until a Save 
command is given.  
 
Note that there is no connection between a file name and a label. Moreover, you need not 
save a specification to a file. Once a specification has been imported into the SIM 
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SETTINGS Program Table, it will continue to reside within the table and will be 
retrievable for as long as HeLPS is running. Care must be taken, however, since any 
specification contained within the Program Table might be overwritten at some later time, 
leaving no record of the original. If you think you will want a record of a specification in 
the future, you should save it to a file.  
 
You can import a previously-saved specification into the HEARING window. To do so, 
go to the File menu, select Open, and navigate to the .hrg file you wish to open. Before 
the new specification is imported, a prompt will ask you to save the current specification.   
 
You can also import a hearing specification into the HEARING window from the SIM 
SETTINGS Program Table.  This is done in either of two ways: (1) single-click on the 
desired specification in the Program Table, select Copy from the Edit menu (or press 
Ctrl-c), click on the HEARING window tab, and then select Paste from the Edit menu (or 
press CTRL-v) or (2) link the specification to the HEARING window as described in the 
following paragraph.  Note that method 1 does not link the HEARING window to the 
simulation. 
 
The process of linking allows you to have the changes you make in the HEARING 
window be implemented immediately in the active simulation. In order to be linked, a 
hearing specification must be loaded into the SIM SETTINGS Program Table.  Link the 
hearing specification to the HEARING window by double-clicking on its label in the 
Program Table. This will cause three things to happen: 1) it will make that specification 
the active one; 2) it will bring up the HEARING window; and 3) it will link the 
HEARING window to the simulation. In this linked state, the changes you make in the 
HEARING window will be made immediately to the ongoing simulation, giving you 
direct active control. This linked state is indicated in the HEARING window by an 
asterisk to the left of the label box; in the SIM SETTINGS window it is indicated by an 
asterisk next to the specification that was double-clicked.  
 
The hearing specification displayed in the HEARING window can be printed. go to the 
File menu and select Print and proceed as usual when printing. A copy of the hearing 
window will be sent to your default printer.  
 
Some example .hrg files are provided in the folder C:\...\HeLPS\work\examples . You 
can Open any of these and use it, or modify and save it, as desired. 
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SPECIFYING SIMULATED PROSTHESES 
 
When the PROSTHESIS tab of the HeLPS interface is clicked, a window appears that 
allows you to specify a prosthesis (if any) for each ear. The buttons above the main plot 
can be used to select the left or right ear, or both ears if the prosthesis is to be the same on 
the two sides. There are three prosthesis options: 1) None (no prosthesis); 2) Hearing 
Aid; or 3) Cochlear Implant. When starting with a New prosthesis specification (by 
selecting New from the File menu), the prosthesis is set to None and the display shows 
the output spectra for three levels (55, 70, and 85 dB SPL) of free-field speech spectra 
modified by the free-field-to-eardrum transfer function (ANSI S3.5, 1997). 
 
No Prosthesis 
If None is selected, no modifications may be made to the displayed output spectra. 
Hearing-specification thresholds can be added to the plots to enable comparisons of 
speech levels to audibility thresholds. The SPL thresholds are derived from the 
audiograms of a hearing specification and can be imported by issuing either of two 
commands in the Import Loss menu: 1) From HEARING Window will load the 
audiograms from the current HEARING window; or 2) From File will load audiograms 
from a selected .hrg file. Thresholds from the current HEARING window may also be 
imported by copying the hearing specification to the clipboard (as described above) and 
choosing Paste (from the Edit Menu) while in the PROSTHESIS window.  This latter 
method will produce a warning that the hearing specification in the clipboard will also be 
imported into the HEARING window. The hearing-threshold display can be de-activated 
by selecting None from the Import Loss menu. 
 
Hearing Aid 
If Hearing Aid is selected, the display of output spectra changes slightly and some 
additional controls appear at the bottom of the window. These graphical and numerical 
controls are used in specifying the characteristics of the hearing aid. To help with the 
specification of the hearing aid, the output band-level plots are continuously updated to 
reflect current settings.  
 
When the Hearing Aid display of a new prosthesis is first entered the default specification 
is identical to None. This “transparent aid” uses an omnidirectional microphone, and has 
fixed linear gain of 0 dB. 
 
While Hearing Aid is selected, two displays are possible, as selected from the View 
Menu: Real Ear Output and Pre-Emphasis. 
 
Real Ear Output  
The Real Ear Output plot shows the hearing aid output third-octave spectra at the 
listener’s eardrum in response to speech-spectrum noise (straight-ahead of the listener) at 
55, 70, and 85 dB SPL. These displayed spectra will reflect changes in the gain-
frequency response resulting from the pre-emphasis filter and the compression amplifier 
hearing aid components described in Figure 6.  
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Note that because these plots apply only to a straight-ahead source, and because there is a 
built-in compensation for the frequency response of a directional microphone, there will 
be no change in the output spectra when you switch between an omnidirectional and a 
directional microphone. Of course, there could be large differences between the output 
spectra from these two microphones if the source were not straight-ahead.  
 
Pre-Emphasis  
The Pre-Emphasis plot shows the shape of the pre-emphasis filter from Figure 6. This is 
an adjustable linear filter that is provided to allow for spectral shaping prior to 
compression. The plot that appears shows the idealized magnitude response of the pre-
emphasis filter. This filter is controlled by changing the cutoff frequency fc (by clicking 
and dragging the green vertical line) and the slopes of lines above and below fc (by 
clicking and dragging the square handles). The filter gain at fc is fixed at 0 dB and the 
lines have fixed slopes in dB per octave. The gain of the pre-emphasis filter is limited as 
shown to the range from -60 to +20 dB. Gain may be limited below +20 dB if the 
resulting output level from any channel (with 85 dB speech spectrum noise) exceeds the 
maximum channel output level. Likewise, filter gain may be limited above -60 dB if the 
resulting output level from a channel would go below the compression knee value with 
55 dB SPL speech spectrum noise. Such limits on gain are indicated in the telltale.  
 
Microphone 
Either Omnidirectional or Directional microphones must be selected. Recall that 
directional microphone processing includes compensation to make the on-axis (0o) 
frequency response the same for omnidirectional and directional microphones. As a result, 
switching from one to the other causes no change in the displayed output spectra. 
 
Volume Range and Control  
The third-octave spectra of speech-shaped noise shown in the real ear output plots are 
calculated on the assumption that the volume control is at 0 dB gain. The range of gain 
allowed in the volume control can be specified, but this range must include 0 dB; i.e., 
allowed entries in the left box must be less than or equal to 0 and in the right box must be 
greater than or equal to 0. If no volume control is desired, enter 0 in both boxes.  
 
The main prosthesis volume control is located in the SIM SETTINGS window.  When 
the PROSTHESIS window is linked to the active simulation (as described below), a 
duplicate volume control is visible to the right of the plot box in the PROSTHESIS 
window for convenient access The volume control steps are fixed at 1 dB.  
 
Compressor 
Advanced compressor controls are accessed by activating them from the View menu. If 
you simply wish to use default values for the compressor, you can leave these controls 
hidden.  
 
The compressor provides independent automatic gain control in up to three frequency 
channels. The crossover frequencies between channels are indicated on the Real Ear 
Output plots by the green vertical lines and are adjusted by clicking and dragging these 
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lines. If you want to implement a compressor with only one or two channels, move one or 
both of the vertical lines to the far right of the display.  
 
The input/output characteristic within each compressor channel is composed of line 
segments that you specify indirectly. The procedure is illustrated in Figure 8.  The Input 
Channel Level variable in this plot is the level of speech-spectrum noise within the 
channel in a listener’s open ear canal. The Output Channel Level variable is the level of 
speech spectrum noise in the listener’s ear canal, within the channel, with HeLPS 
implementing the specified aid. Both of these variables depend, of course, on the upper 
and lower frequency limits of the channel.  
 
The input/output curve in Figure 8 is composed of straight lines determined by five points, 
labeled 1-5. The coordinates of these points are determined according to the following 
algorithm. 
 
1) The output coordinates of the three middle points (#2-4) are determined by the 
placement of the three graphic handles, one for each of the three input levels of speech 
spectrum noise, for that channel in the Real Ear Output plot. Although the handle is 
placed graphically on the third-octave spectrum curve, the quantities displayed in the 
telltale are actual channel input and output levels.  
 
2) The output level of point #5, labeled Omax, is an advanced compressor control 
parameter and is set by numerical entry in the ‘max’ boxes for the three channels. Omax 
specifies the maximum output level for the channel, which is controlled via compression 
limiting. The input-level coordinate paired with Omax is determined by the intersection of 
the horizontal line at Output = Omax and the extension of the line joining points 3 and 4. 
As a result, the slope of the compression curve is constant between points 3 and 5.  

Figure 8. Example I/O characteristic for one channel of a compression hearing aid.  
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3) The output level of point #1, point labeled Oknee, is also an advanced compressor 
control and is set by numerical entry in the ‘knee’ box for each channel. Oknee specifies 
the output level for the channel at the lower end of the compression range.  At input 
levels below this point the applied gain is fixed (and hence the slope is 1 dB/dB). The 
input-level coordinate paired with Oknee is determined by the intersection of the horizontal 
line at Output = Oknee and the extension of the line joining points 2 and 3. As a result, the 
slope of the compression curve is constant between points 1 and 3.  
 
It is important to keep in mind that the max and knee output parameters have precedence 
over other parameters. All adjustments to the three middle points (#2-4) will be 
automatically limited by the interface to comply with the max and knee output constraints. 
Note from Figure 6, however, that because the volume control is placed after the 
compressor, it will be possible to increase the volume control and exceed the maximum 
output level specified via the interface. 
 
The temporal parameters for each channel of the compressor are the attack and release 
times, which are entered numerically.  
 
Prescriptions 
The Prescribe menu provides six different threshold-based hearing aid prescriptions. 
Three of these – POGO-II, NAL_RP, and DSL – are for linear hearing aids. The other 
three – FIG6, CR2, and NAL_NL1 are for nonlinear (compression) aids. The three linear 
prescriptions and FIG6 have been implemented in accordance with the descriptions 
provided by Dillon (2001). NAL_NL1 is a proprietary prescription method for nonlinear 
aids available from the National Acoustics Laboratories of Australia. CR2 is a custom 
compression prescription that uses a three-segment compression characteristic in each 
channel obtained by: 1) calculating the gain prescribed by NAL_RP and assigning that 
gain to an input level of 65 dB SPL; 2) using a compression ratio of 2 for input levels 
from 40 to 95 dB SPL; and 3) using a fixed gain below 40 dB and an infinite compression 
ratio above 95 dB SPL.  
 
In order to generate a hearing aid prescription, a hearing specification must first be 
imported into the PROSTHESIS window.  This process is identical to that described 
above for the No Prosthesis description. Prescriptions are calculated for the three overall 
input speech levels of 55, 70, and 85 dB SPL and are shown as dashed lines. A hearing 
aid prescription is then programmed by adjusting the three Real Ear Output level curves 
(using both the compression band tags in the Real Ear Output plot and the Pre-Emphasis 
filter) to match the displayed output curves from the prescription. Note that the hearing 
aid is not automatically programmed to match a prescription; you must manually adjust 
the output level curves using the graphic handles. If you wish to remove the prescribed 
curves from the plot, select None from the Prescribe menu. 
 
Simulation Limits 
The maximum output of a HeLPS hearing aid is a parameter that can be adjusted. The 
largest maximum output allowed by the interface is 110 dB SPL within a channel. These 
high output levels are made available in order to simulate high-gain hearing aids. If such 
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high levels are not needed, you should set the maximum output level to a lower value, 
such as 90-100 dB SPL.  
 
Cochlear Implant 
If Cochlear Implant is selected, the display of output spectra changes slightly and some 
additional controls appear at the bottom of the window. These controls are used to 
specify the characteristics of the implant. To help with the implant specification, the 
output band-level plots are continuously updated to reflect current settings.  
 
While Cochlear Implant is selected, two displays are possible, as selected from the View 
Menu: Real Ear Output and Pre-Emphasis. 
 
Real Ear Output  
The Real Ear Output plot shows the third-octave spectra produced by the implant 
simulation at the listener’s eardrum in response to speech-spectrum noise (straight-ahead 
of the listener) at 55, 70, and 85 dB SPL. These displayed spectra will reflect the number 
of cochlear implant channels used and changes in the gain-frequency response resulting 
from the Rre-Emphasis filter as described in Figure 7. 
 
Note that because these plots apply only to a straight-ahead source, and because there is a 
built-in compensation for the frequency response of a directional microphone, there will 
be no change in these idealized output spectra when you switch between an omni-
directional and a directional microphone. Of course, there would be large differences 
between the output spectra from these two microphones if the source were off-axis.  
 
Pre-Emphasis Filter 
The Pre-Emphasis plot shows the shape of the Pre-Emphasis filter from Figure 7. This 
filter is controlled by changing the central frequency fc (by clicking and dragging the 
green vertical line) and the slopes of lines above and below fc (by clicking and dragging 
the square handles). The filter gain at fc is fixed at 0 dB and the lines have fixed slopes in 
dB per octave. The gain of the pre-emphasis filter is limited as shown to the range from -
60 to +20 dB. Gain may be limited below +20 dB if the resulting output level from any 
channel (with 85 dB speech spectrum noise) exceeds the maximum channel output level. 
If that limit is reached it will be so indicated by a telltale.  
 
Microphone 
Either Omnidirectional or Directional microphones must be selected. Recall that 
directional microphone processing includes compensation to make the on-axis (0o) 
frequency response the same for omnidirectional and directional microphones. As a result, 
switching from one to the other causes no change in the displayed output spectra. 
 
Volume Range and Control  
The third-octave output spectra shown in the Real Ear Output plots are calculated on the 
assumption that the volume control is at 0 dB gain. The range of gain allowed in the 
volume control can be specified, but this range must include 0 dB; i.e., allowed entries in 
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the left box must be less than or equal to 0 and in the right box must be greater than or 
equal to 0. If no volume control is desired, enter 0 in both boxes.  
 
The main prosthesis volume control is located in the SIM SETTINGS window.  When 
the PROSTHESIS window is linked to the active simulation (as described below), a 
duplicate volume control is visible the right of the plot box in the PROSTHESIS window 
for convenient access The volume control steps are fixed at 1 dB.  
 
Number of Channels 
The number of Channels in the simulation must be between 1 and 20, inclusive. 
 
Carrier 
Either a band of noise or a tone at the center frequency of each band can be used as the 
Carrier in the simulation.  
 
Simulation Limits   
As described in “Prosthesis Simulation,” an adjustment in the simulation of cochlear 
implants must be made to accommodate the fact that a cochlear implant provides low- 
and moderate-level auditory stimulation to a person with very large hearing loss. In order 
to best simulate these conditions, HeLPS delivers the implant simulator output at a 
moderate level, and in order for the listener to perceive that output signal Normal 
Hearing must be used with the simulated implant.  
 
Copying, Saving, Importing, Linking, and Printing 
The entire collection of data that describes a binaural pair of prostheses (including None) 
is called a prosthesis specification. A prosthesis specification must have an identifying 
label in the box at the top of the window. The interface will not allow the label box to be 
empty and will insert a label such as “Untitled Prosthesis 1” if necessary.  
 
Two forms of copying prosthesis specifications are possible.  First, if you are specifying a 
prosthesis for one ear, you can copy that specification to the other ear by clicking the 
copy button to the right of the plot. These buttons can save you time when specifying a 
prostheses that are similar between the ears.  
 
Second, you can copy a prosthesis specification to a “clipboard” for use in other windows 
of the HeLPS interface. For example, if you want to copy the current prosthesis 
specification to the Program Table in the SIM SETTINGS window, you can first copy it 
to the clipboard (by going to the Edit menu and selecting Copy or by typing Ctrl-c), then 
switch to the SIM SETTINGS window, and then paste it into a slot in the table (by going 
to the Edit menu and selecting Paste or by typing Ctrl-v).  
 
The on-screen prosthesis specification can be saved to a prosthesis file, which will be 
given the extension “.pros”. To save a specification to a file, go to the File menu, select 
Save As, and then specify a folder and file name in the usual way. The file name will then 
be displayed in the title bar at the top edge of the window. Before the specification was 
saved to a file a temporary name such as Untitled_Prosthesis_3 was displayed there. 
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Changes made in a specification window are not made to the associated file (if there is 
one) until a Save command is given.  
 
Note that there is no connection between a file name and a label for a specification. 
Moreover, you need not save a specification to a file. Once a specification has been 
imported into the SIM SETTINGS Program Table, it will continue to reside within the 
table and will be retrievable as long as HeLPS is running. Care must be taken, however, 
since any specification contained within the Program Table might be overwritten at some 
point, leaving no record of the original. Thus, if you think you will want a record of a 
specification in the future, you should save it to a file.  
 
You can import a previously-saved specification into the PROSTHESIS window. To do 
so, go to the File menu, select Open, and then navigate to the .pros file you wish to open. 
Before the new specification is imported, a prompt will ask you to save the current 
specification.  You may also import a prosthesis specification from the SIM SETTINGS 
Program Table.  This may be done in one of two ways: (1) single-click on the desired 
specification in the Program Table, select Copy from the Edit menu (or press Ctrl-c), 
click on the PROSTHESIS window tab, and then select Paste from the Edit menu (or 
press CTRL-v) or (2) link the specification to the PROSTHESIS window as described in 
the following paragraph.  Note that method 1 does not link the PROSTHESIS window to 
the simulation. 
 
The process of linking allows you to have the changes you make in the PROSTHESIS 
window be implemented immediately in the active simulation. In order to be linked, a 
prosthesis specification must be loaded into the SIM SETTINGS Program Table.  Link 
the prosthesis specification by double-clicking on its label in the Program Table. This 
will cause three things to happen: 1) it will make that specification the active one; 2) it 
will bring up the PROSTHESIS window; and 3) it will link the PROSTHESIS window to 
the simulation. In this linked state, the changes you make in the PROSTHESIS window 
will be made immediately to the ongoing simulation, giving you direct active control. 
This linked state is indicated in the PROSTHESIS window by an asterisk to the left of the 
label box; in the SIM SETTINGS window it is indicated by an asterisk next to the 
specification that was double-clicked.  
 
The information contained in the prosthesis specification can be printed. To do so, make 
sure that the desired specification is loaded into the PROSTHESIS window, go to the File 
menu and select Print and proceed in the usual way as with other Windows products.  
 
Some example .pros files are provided in the folder C:\...\HeLPS\work\examples. You 
can Open any of these and use it, or modify and save it, as desired. 
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CONTROLLING THE SIMULATION 
 
Clicking the SIM SETTINGS tab of the HeLPS interface brings up a window that allows 
you to:  

1) load hearing and prosthesis specifications into the Program Table, select them for 
the current simulation, control prosthesis volume level, and store complete 
Program Tables as files for future use; 

2) select Target, Noise, and Environment characteristics for the simulation;   
    and, 
3) Play and Pause presentation of target stimuli and select whether audio only, video 

only, or both components of an audio/video stimulus are presented.  
 
Working with the Program Table 
The Program Table has six slots for hearing specifications and six for prosthesis 
specifications. Hearing specification #1 and prosthesis specification #1 are fixed at 
Normal Hearing and No Aid, respectively, and are not programmable. The remaining 
slots in the table (#2-6) can be filled by five hearing specifications (left column) and five 
prosthesis specifications (right column). These specifications are identified by the labels 
given to them in their respective specification windows. Specification labels cannot be 
changed in the SIM SETTINGS window.  
 
A specification can be loaded into a slot from either of two sources, the specification 
window or a file.  
 
1) Loading from a specification window. A hearing or prosthesis specification can be 
copied in its entirety from its specification window and pasted into a slot in the Program 
Table. This copying can be done in either of three ways: 
 

a) While in the specification window, go to the Edit Menu and select Copy (or, 
simply type Ctrl-c). Then go to the SIM SETTINGS window, single-click on the 
slot into which the specification is to be inserted, and select Paste from the Edit 
menu (or, type Ctrl-v). The label for that specification will be placed in the slot, 
indicating the specification has been copied. 

 
b) In the SIM SETTINGS window, click the slot in the Program Table into which 

you wish to load a new specification. Then go to the Import Specification menu 
and select From Hearing (or Prosthesis) Window. The specification that is loaded 
will replace the specification that previously occupied that slot. A short-cut to the 
Import Specification menu is available by right-clicking on a label.  

  
c) If you double-click on a label, then that specification window (either hearing or 

prosthesis) is brought to the foreground displaying the specification assigned to 
that label. As described in previous sections, double-clicking on a label 
establishes an interactive link so that changes made in the specification window 
(including its label) are made immediately in the Program Table, and 



HeLPS User Guide                                                                                                                                   29   

 SENSIMETRICS CORPORATION 

consequently, in the currently-active simulation. The existence of a link is 
indicated by an asterisk to the left of the label.  

 
2) Loading from a file. A hearing or prosthesis specification that was previously stored in 
a file may also be loaded. First click on the slot in the Program Table into which you 
wish to load the stored specification. Then select From File in the Import Specification 
menu. This will bring up a dialog box for specifying the file. Note that the two steps of 
clicking on the slot and going to the Import Specification menu can be reduced to one 
click. Just right click on a slot to bring up the Import Specification menu in a pop-up 
window.  
 
In addition to copying from a specification window and importing specifications, any 
specification that is already in the Program Table can be copied and pasted into another 
slot in the Table. This can be useful when creating a specification that differs slightly 
from an existing one. To do this, highlight the specification’s label by single-clicking on 
it. Then type Ctrl-c to copy it to the clipboard (or go to the Edit Menu and select Copy). 
Click in the slot into which you wish to insert this specification and then paste it in by 
typing Ctrl-v (or selecting Paste from the Edit Menu).  
 
It is important to remember that there is no logical connection among labels in the 
Program Table. It is up to you to avoid giving different specifications the same label. If a 
label appears more than once in a table, even if for the same initial specification, a change 
in one of those specifications does not propagate to others with the same label.  
 
In addition to the file operations with individual specifications, it is possible to save the 
entire Program Table to a program file (with a “.prog” extension). To do so, go to the File 
Menu and select Save or Save As. When a Program Table is saved all of the 
specifications contained in it are saved along with it. Program files can be loaded by 
selecting Open from the File Menu. A Program Table can be printed by selecting Print 
from the File Menu.  
 
The example program file Assorted.prog, which was used in the Quick Start tutorial, is 
provided in the folder C:\...\HeLPS\work\examples. You can Open this file and use it, or 
modify and save it, as desired. 
 
Stimulus Selection and Playback Control  
HeLPS provides flexible control over the selection of target and noise stimuli that are 
delivered as inputs to the prosthesis and hearing loss simulators.  
 
Target Settings 
Targets are the audio or audio/video stimuli that are presented when the Play button is 
clicked.  
 
There are two sources of target stimuli. The first, the HeLPS A/V Clips, is a collection of 
about 400 audio/video recordings of everyday sentences spoken by ten talkers -- five 
females and five males. These talkers exhibit a range of regional accents, voice quality, 
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speaking habits, and speech-readability. Using the pull-down menu, you can select any 
one of these talkers, or all of them, or all talkers of the same gender, as the subset to 
sample. Sentences are picked at random (with replacement) from the selected subset. 
 
The second target source, User-Supplied Stimuli, allows you to use as a target any audio 
file, or collection of audio files (in .wav format), that you have stored on your PC. To 
make files available for access by HeLPS, you must first specify their location. By 
default, HeLPS looks to the folder labeled UserStimuli within the main HeLPS 
installation folder. If you wish to use audio files stored elsewhere, you can change the 
target folder by going to the Advanced menu in the SIM SETTINGS window and 
choosing Select User Stimuli Folder. 
 
When User-Supplied Stimuli is selected, HeLPS automatically populates the source drop-
down (or scroll) menu with the contents of the specified User Stimuli Folder.  HeLPS 
interprets these contents in the following way: individual .wav files are regarded as 
single-stimulus sources while subfolders are regarded as playlists (consisting of the .wav 
files contained within the subfolder). If you select an individual .wav file it will be 
repeated until Pause is clicked or HeLPS is exited. If you select a subfolder, all the .wav 
files in that folder will be played in the alphabetical order of their filenames, with that 
presentation repeated until stopped. (Subfolders within the selected subfolder are 
disregarded). Valid .wav files for use with HeLPS must contain a one-channel signal 
sampled at one of these sample rates: 48, 44.1, 24, 22.05, 16, 12, or 11.025 kHz. If 
HeLPS detects a stereo signal, it will produce an output using only the left channel. If 
HeLPS detects a signal with a valid sampling rate (from the list above), it will re-sample 
it at the default HeLPS sampling rate of to 22.05 kHz for processing and output. Signals 
with invalid sampling rates will be ignored. User-supplied target stimuli are processed 
just like HeLPS A/V targets to simulate arrival from straight-ahead, and are further 
processed to add reverberation if that option is selected.  
 
Sample stimuli are provided in the HeLPS/UserStimuli folder. These samples include 
tones, noise bands, music, spoken passages, and environmental sounds.  
 
Be aware that because of the intensive processing performed by HeLPS, there is an initial 
delay in the presentation of User Stimuli. This delay increases with the length of the file. 
If a single file is repeated, however, the gap between repetitions is very short.  
 
A Repeat switch is provided to allow you to repeat one stimulus continually. This 
capability is convenient for making direct comparisons among hearing losses or 
prostheses with the same stimulus.  
 
Target Level represents the level of the direct sound wave at the listener’s location (equal 
to overall level in an anechoic environment). In reverberation the target level at the 
listener’s location is slightly higher than the nominal level due to the added reverberant 
energy. A typical level for normal conversational speech is 65 dB SPL.  
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User-Supplied Stimuli are scaled to be presented at the selected Target Level. However, 
this scaling must be done carefully to avoid problems that would result, for example, if 
the RMS average were to be calculated over a long-duration audio signal that has only a 
brief burst of high-amplitude signal. The algorithm that is used in scaling a signal to 
achieve a given output level is based on taking a running average with a 0.5-sec time 
constant through the entire file. The scaling is done so that the largest output from this 
averager is equal to the specified sound level in dB SPL.  
 
An additional option with User-Supplied Stimuli is to have no scaling applied. This  
No Scale option gives you direct control over the signal level. In order to make use of this 
to achieve a given sound pressure level, you will need to know that the mapping used for 
scaling in HeLPS is that an RMS value of 3500 calculated on a digital signal (regarding 
the 16-bit samples as integers ranging from -32768 to 32767) corresponds to an input 
sound level (in the free field at the listener’s center-head position) of 85 dB SPL.  
 
Noise Settings 
There are two types of noise provided with HeLPS – Speech-Shaped Noise and Party 
Noise. Speech-Shaped Noise is random noise that has been filtered to give it the spectral 
shape of the long-term speech spectrum. The direction of arrival of this noise can be 
chosen to be either straight-ahead (0o) to the listener’s left (-90o), right (90 o), or rear 
(180o).  Speech-Shaped Noise can also be chosen to be diffuse – arriving from all 
directions.  
 
Party Noise is composed of individual talkers from many directions. If Party Noise is 
selected there are no options for selecting direction of arrival.  
  
Noise level can be selected, and it can be presented nearly continuously (with brief 
interruptions) or only coincident with each target stimulus.  
 
Environment Settings 
Two degrees of reverberation can be selected. Anechoic represents a very low degree of 
reverberation, typical of a room with extensive absorption (e.g., thick carpeting, drapes, 
upholstery). The moderate degree of reverberation is typical of a very ‘live’ room with 
little acoustic absorption, such as a kitchen. Note that these settings describe the 
reverberation added to the target+noise stimuli. If you supply targets that are already 
reverberant, they will still be reverberant even if you select Anechoic, and they will have 
increased reverberation if you select “Reverberant.” 
 
Volume Control 
The volume control to the right of the Program Table controls prosthesis volume (both 
together if two prostheses are used).  
 
Playback Control  
To enable demonstrations of the value of the visual signal for speechreading (and, the 
audio signal for listening), controls are available under the video window for turning off 
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either the video or the audio. When audio-only stimuli are being played these controls are 
de-activated.  
 
Advanced Playback Control  
Because the real-time simulations implemented by HeLPS are computationally intensive, 
some computers may have problems playing audio/video stimuli or even audio-only 
stimuli with hearing loss and hearing aid simulations in effect. Problems are more likely 
with older computers, many of which are slower and have less memory than current 
(mid-2006) PCs. To accommodate such PCs as much as possible, HeLPS provides 
controls that can be adjusted by the user to optimize performance. These Playback 
Settings are available under the Advanced menu in the SIM SETTINGS window.  
 
The Current Statistics in the Playback Settings window summarize error rates (over the 
recent past) for audio and video processing. Ideally, these would both be zero. 
Realistically, however, there will be occasional errors. If these rates are low enough the 
errors will not be noticed. If error rates increase beyond about 10%, however, there will 
be noticeable problems in stimulus delivery.  
 
If you notice problems in the audio output, try adjusting the Processing Buffer size. 
Increasing this parameter will lead to fewer dropped audio blocks at the cost of slower 
response to changes. In general, try to set Processing Buffer Size to be the smallest value 
that yields audio with no stutters. The Gap Noise Growth Rate parameter affects 
processing required when the Continuous option is selected. Make this parameter as large 
as possible without producing audio stutters in the noise in the inter-stimulus period. 
 
Video problems will most likely arise from dropped frames, which cause the video image 
to jump abruptly. If you see such problems, you may have to reduce Image Quality 
and/or decrease Image Size. The low Image Quality setting produces images that are 
noticeably pixellated when viewed from a short distance. Decreasing Image Size makes 
the pixellation less visible, at the cost of a smaller image.  
 
A final piece of advice regarding HeLPS playback problems is to close other applications 
and accounts that may be open in the background. Demands from other programs can 
slow the time-critical computation required by HeLPS.  
 
Storing Audio Output  
A selection under the Advanced menu allows you to store the processed simulator output 
to an audio file. If you turn this feature on, a Save Output Signal dialog box will appear 
following each stimulus presentation, enabling you to give that audio file a name and 
save it. All changes that you make during the stimulus presentation will be recorded to 
the output file except for changes in tinnitus. For technical reasons, the tinnitus settings 
that are in effect at the end of the stimulus presentation will be implemented throughout 
the entire stored stimulus, even if changes to tinnitus settings were made during 
presentation.  
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Presenting Simulations to Multiple Listeners 
When there is more than one person who is to listen to a demonstration, it would be 
efficient to deliver the simulator output to all of them in parallel rather than have them 
listen sequentially with one set of headphones. One way to achieve simultaneous 
listening is to use multiple sets of headphones connected in parallel. Audio adapters that 
enable connection of multiple headsets to one audio output jack can be obtained from 
consumer electronics outlets. Assuming that your audio system is capable of driving the 
desired number of headsets, and assuming that the headsets are all the recommended 
Sennheiser HD 201, the only other consideration is that all of the listeners have a good 
view of the video display, if there is one. 
 
Another solution for multiple listeners is to deliver the output signals from loudspeakers. 
This approach has several limitations, however, that must be understood. These 
limitations arise because the left and right simulator outputs are designed to be delivered 
to left and right calibrated earphones. Delivering them instead to loudspeakers can be 
done if the loudspeakers are set up and calibrated properly and then used with an 
understanding of the limitations.  Follow these steps if using loudspeakers.  
 
1) Position the two loudspeakers to either side of, and equally displaced from, the PC 
monitor on which videos (if any) will be viewed. The angle from straight-ahead of the 
listener to either loudspeaker should be between 30o and 60o, and equal for the two 
loudspeakers. Try to keep the distance from the loudspeakers to the listener’s location as 
short as practically possible (within about one meter) in order to minimize effects of 
room reverberation.   
 
2) After the loudspeakers are positioned, perform a calibration like that described in the 
Software Installation and Audio Setup section of this User Guide. Deliver stimuli as 
described there from the loudspeakers and either measure (if using measurement 
equipment) or adjust the volume to achieve the calibration criterion.  
 
3) When giving demonstrations with loudspeakers, keep in mind that the simulation will 
be invalid for any condition in which separation of the signals to the two ears is critical. 
For example, it would make no sense to attempt to simulate a highly-asymmetric hearing 
loss using loudspeakers because the signal intended for the better ear will be delivered 
also to the poorer ear, and vice versa. Likewise, a large hearing aid gain on one side will 
result in that amplified signal reaching both ears when using loudspeakers. As a result of 
these constraints, the simple rule that governs the use of loudspeakers is:  

 
When using loudspeakers, only simulate hearing losses and prostheses 
that are left-right symmetric. 

 
With respect to spatial effects of the noise sources, the listener will notice that Speech-
Shaped Noise to the left or right will be localized at the left or right loudspeaker, 
respectively. Diffuse noise and Party Noise will tend to be localized in-between the two 
loudspeakers instead of all around the listener.   
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